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I. BOM Extractor

7 = wRd "
Home  Tools  View  Help
=1 B variants: Variante 4,11 = Not filterad
= E-S-l Schemmas | WS Schems w4 - C" No filter colurn
ear
Components  selected  Selected ltems: 28128 Selected Variants 7 /7 firer Mo filter value
Home &
Expot ComponentName  FPatnumber  Patname  Quanity  Fited  Valus Postion’X ~ CenterX  PostionY  CenterY  Oriertation  Manufacturer | A

D1 101403 T4 1 FITTED |1N814 | MasterVariants | 32500 40000 2700 PHILIPS
D1 101403 Ng14 1 FITTED |1NS14  [Varanie A 32500 4000.0 2700 PHILIPS
D1 101403 T4 1 FITTED |1N814  |Vararte A1 32500 40000 2700 PHILIPS
D1 101403 314 1 FITTED |1NS14  |Vareme A1 32500 40000 2700 PHILIPS
D1 101403 T4 1 FITTED |1N914  |Vararte 8 2500 40000 2700 PHILIPS
D1 101403 314 1 FITTED |1NS14  |VaremeBA 32500 40000 2700 PHILIPS
D1 101403 14 1 FITTED | 1Ng14  |VararteC 22500 40000 2700 PHILIPS
R1 100404 TKTRe2% |1 FITTED 77K |VereteA11 36500 38500 00

R1 100404 TKTRe2Y |1 FITTED 77K [VaranieC 3650.0 38500 00

R1 102561 SKD-TR42% |1 FITTED | 5KO Vararte A1 36500 38500 00

R1 102561 5KO-TR&2% |1 FITTED |5K0 Variarte B 3650.0 38500 00

R1 102561 SKD-TR42% |1 FITTED | 5KO Vararte B1 36500 38500 00

R1 101583 WTREZY |1 FITTED |37K Master-Variante | 36500 38500 00

v

Output Directory: D:A2015\BOM_Exiractor\Output \All_Variants

Eine meist aufwandige und somit zeitintensive Aufgabe ist das Erstellen von Stiicklisten und Priiflisten fur ein
CADSTAR-Design wahrend der Entwicklung. Der BOM-Extractor stellt Ihnen hierfir leistungsfahige Funktionen
bereit, um diese Aufgaben schnell und einfach zu erledigen.

Der BOM Extractor unterstitzt Sie in folgenden Bereichen:

e Erstellung detailierter Sticklisten
Erstellung akkumulierter Stiicklisten
Unterstltzung verschiedener CSV-Formate sowie XML und RTF
Konfigurierbare automatische Nummerierung
Filterung nach Baugruppen und weiteren Eigenschaftswerten
Erstellung der Listen von einzelnen Varianten oder bequem uber alle Varianten
Auflistung der Bauteile von einzelnen oder allen Sheets
Listen von Bauteilen und/oder Testpunkten
Listen unter Ausnahme vom Kunden definierter Bauteile
Ausgabe von nicht bestlickten Bauteilen
Lokalisieren eines Listenteiles im CADSTAR-Design
Abspeichern von Report-Schemas
Vollintegration in CADSTAR mdglich



II. Installationsanleitung fir CADSTAR BOM Extractor

Mindestanforderung an das System

Windows XP

Prozessor mit 500 MHz oder mehr

128 MB Arbeitsspeicher oder mehr

Ca. 80 MB freier HDD Speicher

NET.Framework 2.0 (falls nicht vorhanden wird es wahrend der Installation mit installiert)

Vorbereitungen fur die Installation
Bitte schlie3en Sie vor dem Installieren alle anderen Anwendungen.

Lizensierung

Zur Aktivierung der Lizenz benétigen Sie einen Lizenzcode, der auf Ihrer MAC-Adresse referenziert. Die
MAC-Adresse dient als eindeutige Identifikation eines jeden Gerates innerhalb eines Netzwerkes und ist somit
relevant bei der Zuteilung der Lizenz/des Lizenzcodes. Zur Ermittlung gehen Sie bei einem deutschen
Betriebssystem wie folgt vor: Auf Start=> Ausfiihren (oder in das Feld Programme/Dateien durchsuchen)
klicken und "cmd" eingeben. Danach in der erscheinenden Eingabeaufforderung den Befehl "ipconfig /all"
eintippen und mit der Eingabetaste bestéatigen (natirlich ohne die Anfihrungszeichen). Die-MAC Adresse lasst
sich nun unter der ,Physikalischen Adresse* ablesen.

BMEthernetadapter rechner 2:

Medienstatus. . . Es besteht keine Uerbhin

Beschreibung. . . IBM 18,188 EtherJet—PCI
Physikalische Adresse - B8-84-AC-65—-34-A6

dapter

Bei einem englischen Betriebssystem sind die entsprechenden Befehle: Start> Run, geben Sie ,cmd® ein und

abschlieBend wieder "ipconfig /all". Hier findet sich die MAC-Adresse unter ,Physical Adress”. Senden Sie diese
MAC-Adresse bitte per Email an Kluwetasch@cskl.de oder Wadim.Stieben@cskl.de und Sie erhalten innerhalb
eines Arbeitstages den Lizenzcode. MAC-Adresse holen...



mailto:Kluwetasch@cskl.de%20oder%20Wadim.Stieben@cskl.de
http://cskl.de/bom-extractor-6/ressourcen-faq.html

Installation

Die Installation kdnnen Sie ohne Lizenzcode durchfiihren. Nach dem Doppelklicken auf die
,CS_BOM_Extractor_Setup DE.exe" Datei fangt das Setup an, die Installation vorzubereiten.

Installation wird vorbereitet...

BOM-Extractor 15.0 Setup bereitet den InstaliShield Wizard
vor, der Sie durch den Setup-Vorgang leiten wird. Bitte
warten,

Entpackung |4uft: BOM-Extractor 15.0.msi

Nach der Vorbereitung des ,Install Shield Wizards* 6ffnet sich das ,Willkommen*® Fenster, klicken Sie hier auf
~Weiter".

Die AGBs

Bitte lesen Sie sich die Allgemeinen Geschéftsbedingungen sorgfaltig durch. Um die Installation weiter
fortzuflhren, markieren Sie ,lch akzeptiere...“ und driicken anschlieend auf ,Weiter*.

Lizenzvereinbarung

Bitte lesen Sie nachfolgende Lizenzvereinbarung sorgfaltig durch,

CSK CADSYSTEME- SOFTWARE LICENCE AGREEMENT -~

PLEASE REVIEW THE LICENCE AGREEMENT BELOW. BY OQFENING
THIS SCFTWARE OR CTHERWISE DOWNLOADING CR CCPYING THIS
SOFTWARE, YOU ARE AGREEING TO BE BOUND BY THE TERMS OF
THIS AGREEMENT. DO NOT USE THIS SOFTWARE UNTIL YOU HAVE
CAREFULLY READ AND AGREED TO THE FOLLOWING TERMS AND
CONDITIONS. IF YOU DO NOT RGREE IC THE TERMS OF THIS
AGREEMENT, DO NOT INSTALL OR USE THIS SOFIWARE.

v

(®)3ch akzeptiere die Bedingungen der Lizenzvereinbarung:

(") 1ch lehne die Bedingungen der Lizenzvereinbarung ab

InstallShield

< Zuriick ” Weiter > || Abbrechen

Angaben zum Benutzer und Unternehmen

Unter ,Benutzername® tragen Sie den Namen des Benutzers ein, im Feld ,Unternehmen® den Namen lhrer
Firma.

Benutzerinformationen

Geben Sie bitte Thre Informationen ein.

Benutzername:
|esk_user

Unternehmen:

[eskl

InstallShield

< Zuriick ” Weiter > || Abbrechen
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Auswabhl des Installationspfades

Wenn Sie BOM-Extractor komplett und auf dem Standard Pfad installieren mdchten, dann wahlen Sie bitte
,Vollstandig“ (Haben Sie ,Vollstandig” gewabhlt, lesen Sie bitte ab Schritt 8. Starten der Installation weiter).

Wabhlen Sie ,Benutzerdefiniert”, wenn Sie einen anderen Pfad auswéahlen mochten.

Wiahlen Sie den Setuptyp, der Ihren Anforderungen am besten entspi

Angepasstes Setup

Wahlen Sie einen Setuptyp aus.

(® Nollstandig:

() Benutzerdefiniert

Benutzer.

InstallShield

Alle Programmfeatures werden installiert. (Benitigt den meisten
Speicherplatz.)

Wahlen Sie aus, welche Programmfeatures installiert werden sallen
und wo diese gespeichert werden sollen. Empfohlen fir erfahrens

Wahlen Sie die Features, die Sie installieren machten,

Klicken Sie auf eins der Symbole in der Liste, um die Art einer Feature-Installation zu &ndern.

=M |s0M_Extractor_15.0_Files|

Feature-Beschreibung

Dieses Feature benatigt 8577KB
auf Threr Festplatte,

Installieren in:

InstallShield

€:\Program Files (x86)\CSK - CAD Systeme Kluwetasch\CADSTAR BOM Extractor
15.0} L

< Zuriick ” Weiter > | | Abbrechen ‘ | Hilfe ‘ ‘ Speicherplatz ||

” Weiter > || Abbrechen ‘

Legen Sie den Installationspfad fest
Mit dem Button ,Andern“ kdnnen Sie den Pfad wechseln, mit dem Button ,Speicherplatz® lassen Sie sich den
freien Speicherplatz auf lhren Laufwerken anzeigen. Haben Sie sich fir einen Pfad entschieden, dann klicken

Sie auf ,Weiter*.

Starten der Installation

licken Sie auf ,Installieren” um die Installation zu starten.

Finish

Bereit das Programm zu installieren

Der Assistent ist bereit, die Installation zu beginnen.

Klicken Sie auf “Installieren”, um mit der Installation zu beginnen.

Klicken Sie auf "Zuriick”, wenn Sie Thre Installationseinstellungen uberpriifen oder dndern
wollen. Klicken Sie auf "Abbrechen”, um den Assistenten zu beenden.

InstallShield

<guick || Instalieren | | Abbrechen

Ist die Installation erfolgreich abgeschlossen worden, klicken Sie auf ,Fertig stellen®.

InstallShield Wizard abgeschlossen

Der InstallShield Wizard hat BOM-Extractor 15.0 erfolgreich
installiert. Klicken Sie auf "Fertig stellen”, um den Assistenten
2u verlassen,

< Zurick Eertig stellen Abbrechen
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Ill. Der erste Start des BOM Extractors

Voreinstellungen

Standardmé&Rig werden alle Parts aus der derzeitigen Variante bzw. des aktuellen Sheets aus dem geladenen
CADSTAR Design importiert. M6chten Sie dies andern, kdnnen Sie Uber den Mentpunkt Tools>Settings die
jeweiligen Einstellungen unter Import vornehmen.

gy 5 w8 E F
Home  Tools  View  Help
Ely ¢ Variants Variante A1.1 | % Notfitered
Gi‘ B schemas: WS_Schema_v4
Components  sclected  Selectedltems: 28728 Selected Variants {7 /7
General
Home Choose your available settings |
ot C: 4 Patrumber  Patname  Quantty  Fted  Vae B e 1) Aays Top Mot
o1 101403 HgT4 1 FITTED | 1N914 Weru St O ;:: ms:: £
Inport
D1 101403 1Ng14 1 FITTED | 1N914 Expott [ Ao Gear
D1 101403 1NST4 1 FITTED | IN914
o1 101403 NgT4 1 FITTED | IN914 P
o
o1 101403 1Ng1e 1 FITTED | 1N914
D1 101403 1NST4 1 FITTED | IN914
D1 101403 N914 1 FITTED | TN914 ekt plemass
A1 100404 TKITREZE |1 FITTED | 77€ ‘Schema Folder
R1 100404 TKITReZL |1 FITTED | 77K [D:12015\60M_Extractor\Schemas ]
Rl 102561 SKOTRe2% |1 FITTED | 5KD Choose Schema Folder
A1 102561 SKO-TR42% |1 FITTED | 5KD
R1 102861 5KO-TR42% 1 FITTED | 5KD
R1 101583 IKTTREZE |1 FITTED |37k
Output Directory:  D:\2015\BOM_Extractor\Output\All_Vaniants Hep

Der Import

Zum Importieren der Teile driicken Sie nun einfach auf den Knopf ,Get Components®. Es werden die fir den
Import eingestellten Parts (siehe oben) importiert.

/O = w® O -
Home Tools Wiew Help

E= Get Components
Git‘ Get parts information from CADSTAR
Design (from current designor all
Compenents designs)

AnschlieRend kénnen Sie die Teile auswahlen, welche Sie exportieren mochten.

Exort  PostionMumber Compo

1 1
2 c2

3 c3
4 c4
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Uber den Column-Chooser, den Sie Uiber lhre Rechte-Maus-Taste erreichen, kénnen Sie noch die
Spalten/Bauteil-Eigenschaften, die Sie exportieren méchten, wahlen und in der Reihenfolge veréandern.

Alignment Data View by Column Text
Alignment Data View by Cell Text

Colurmnn Chooser

Iterm Properties

Find in CADSTAR

Selected »
Rows »
Textfilter 2
Varianten Manager 2
Exclusions...

Export 2
Renumber Position

Sert By Order

Copy

Property 2 Property 2

Partname Partnumber

© B

L

Description Partname
Partnumber Quantity
PartDesignVersion Fitted

SymbolDesignVersion Value

[+] [¥]

PositionX v VanantName v
< > < >
Total Columns : 33 Selected Columns © 7

| ok || camesl || Heb |

Nun kdnnen Sie Ihre selektierten Bauteile Uber den Menupunkt File>Export in den Formaten CSV sowie XML
exportieren.

| New Schema 3

Export CSV
Export current view as csv

|
.

Open Schema sl

)

Save Schema

E £

Save Schema As

Reload

%,

E-'S Export -

Options k3 Exit

10



IV. Programmoberflache und Navigation

Die Oberflache des ,BOM Extractors” besteht aus dem zentralen Datenfenster, sowie den beiden Knépfen ,Get
Components®, mit dem Sie die Bauteile aus dem CADSTAR-Design importieren, und ,Set selected items*, die
derzeit im Design markierten Bauteile in der aktuellen Liste zum Exportieren anhakt und bei den restlichen
Bauteilen den Haken entfernt.

» CADSTAR B.O.M Extractor [Schema: D:\2015\BOM_Extractor\Schemas\WS_Schema_v4.xml ] = =
O = & B =
. Home Tools View Help
=) B Varants: Variante A.1.1 -] S Netfiltered
] Schemas : WS_Schema_vd + " Mofilter column
Get Set Clear

Cempenents  selected Selected ltems: 28/28 Selected Variants:7 /7 filter  Mofiltervalue

Home o

Expot  Componenthame Partrumber Partname Quartity Fitted Valug VanantName PositionX CenterX. Posttion’ CenterY Criertation Manufacturer ~

D1 101403 TNg14 1 FITTED | 1N914 Master-Varante  (3250.0 4000.0 2700 PHILIPS

D1 101403 TNg14 1 FITTED | 1N914 | Varante A 3250.0 4000.0 270 PHILIPS

D1 101403 TNF14 1 FITTED | 1N914 | Varante A1 3250.0 4000.0 2700 PHILIPS

D1 101403 NS4 1 FITTED | 1N914 | Varante A1.1 3250.0 4000.0 2700 PHILIPS

D1 101402 TNG14 1 FITTED | IN914 Variarte B 3250.0 40000 2700 PHILIPS

D1 101402 TNG14 1 FITTED | IN914 Variante B.1 3250.0 40000 2700 PHILIPS

D1 101402 TNG14 1 FITTED | INS14 Variante C 3250.0 40000 2700 PHILIPS

R1 100404 JK7TR42% 1 FITTED |77K Variante A.1.1 3650.0 3850.0 0o

R1 100404 TK7TR42% 1 FITTED |77K Variante C 3650.0 3850.0 0o

R1 102561 BKD-TR4-2% |1 FITTED | 5KD Variante A.1 36500 3850.0 0o

R1 102561 BKD-TR4-2% |1 FITTED | 5KD Variante B 36500 3850.0 0o

R1 102561 5KO-TR4-2% |1 FITTED | 5KD Variante B.1 3650.0 3850.0 0.0

R1 101583 I7-TRA2% |1 FITTED  |37K Master-Variante | 3650.0 3850.0 0.0

Output Directory: DAZ015\BOM_Extractor\Output \All_Variants

AuRRerdem besitzt der BOM Extractor wie auch der MRP-Link seit der Version 15.0 eine Ribbon Mendufiihrung.
Mehr Infos zu Ribbon Menus hier: http://de.wikipedia.org/wiki/Ribbon oder hier: https://msdn.microsoft.com/de-
dellibrary/ff799534%28v=vs.110%29.aspx

Das Ribbon Ment wird generell in drei grobe Menlbereiche aufgeteilt: QAT, ORB und Tabs & Panels.

Ribbon QAT (Quick Access Bar)

Die Quick Access Bar ist eine Leiste mit Symbolen fiir einen Schnellzugriff. Hierflihr hat sich das BOM Extractor
Entwicklerteam die vier Funktionsaufrufe ausgesucht, die deren Meinung nach am haufigsten verwendet
werden (Open Schema, Get Components, Export und Options).

Ribbon ORB (Logo Button)

Das ist sozusagen ein Ersatz, fir den fir viele Anwender bekannten Aufruf ,File‘. Hier findet man die
Funktionen, die sonst auch unter ,File‘ zu finden wéaren. Wie z.B. Open, Save, Save As und Exit.

In unserem Fall findet man dort folgende Funktionen: New Schema, Open Schema, Save Schema, Save As
Schema, Reload (Schema), Export, Options und Exit.

Ribbon Tab/Panel

Im Prinzip kann man Tab & Panel mit einer Registerkartei vergleichen. Unter Tabs werden die Hauptmeni
Punkte aufgeteilt, wie z.B. Home, Tools, View und Help. Und darunter kommt dann die logische Zuordnung/
Aufteilung der einzelnen Funktionsaufrufe.

Diese Funktionsaufrufe werden dann gruppenweise getrennt und dargestellt.

Anders als der MRP-Link (MRP-Link hat viel mehr Tabs und auch viel mehr Panels auch innerhalb eines Tabs)
ist der BOM Extractor momentan so aufgeteilt, dass zu jedem Tab auch nur ein Panel erstellt wurde, in dem
dann die Funktionsaufrufe untergebracht wurden. Da der BOM Extractor aber jedes Jahr verbessert wird und
auch fast jedes Jahr neue Funktionen bekommt, kann es sein, dass die Tabs & Panels auch hier erweitert
werden.

11
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V. Die Meni-Leiste

File

1 MNew Schema
|=F Open Schema
A SaveSchema

Save Schema As
& PReload

Export

j Options &4 Exit

New Schema

Es werden alle Einstellungen auf die Werkseinstellungen zuriickgesetzt, um ein neues Schema zu erstellen.
Schemata dienen dazu, Einstellungen, welche im ,BOM Extractor vorgenommen wurden, wieder zu
verwenden. Die hierbei erzeugten Schemadateien kénnen Ubrigens unter den ,BOM Extractor — Anwendern®
ausgetauscht werden, um so die gleichen Parameter zu verwenden.

Ein Schema beinhaltet die Auswahl der Spalten und deren Reihenfolge, sowie alle Einstellungen unter Settings.

Open Schema
Hiermit kann ein bereits abgespeichertes Schema geladen werden.

Save Schema
Speichern Sie hiermit das aktuelle Schema.

Save Schema As
Speichern Sie die aktuellen Einstellungen als Schema unter einem von lhnen vergebenen Namen.

Reload

Laden Sie das aktuelle Schema nochmal nach. Wenn Sie lhr aktuelles Schema verandert haben, kbnnen Sie
hiermit schnell auf die urspriinglichen Einstellungen des Schemas zurticksetzen.

Export

Schreiben Sie hiermit lhre selektierten Parts als CSV oder XML — Datei raus. Weitere Einstellungen hierfur
finden Sie unter Tools>Settings=> Export

Options
Hiermit ruft man die allgemeinen Einstellungen der Applikation auf.

Exit
Beenden Sie hiermit die Applikation.

12



Home

Unter dem Tab/Panel ,Home' findet man all das vor, was vorher dauerhaft in dem BOM Extractor Fenster
gezeigt wurde.

T e

—"’e

< B Variants ! Variante A.1.1 - >’.\ Mot filtered
G? mS_et Schemas ! W5_Schema_v4 - CII No filter column
ear
Components  selected Selected ltems: 28 /28 Selected Variants:7 /7 filker Mo filter value
Home &

Get Components

Hiermit importiert man die Bauteile aus dem aktuell ge6ffnetten CADSTAR-Design. Das ist zu jedem Design
Zyklus maglich.

Set selected items

Hiermit entfernt der BOM Extractor alle Haken aus der Liste und setzt nur die Zeilen mit den Bauteilen, die im
CADSTAR Design wirklich selektiert sind.

Variants

Hier werden alle ausgelesenen Varianten angezeigt und es kann die Variante ausgewahlt werden, die flr einen
interessant ist.

Schemas

Hier werden alle exisitierenden Schemas angezeigt und es kann das Schema ausgewahlt werden, das gerade
bendtigt wird.

Selected Items
Hier wird die Anzahl der selektierten Bauteile angezeigt.

Selected Variants
Hier wird die Anzahl der selektierten Varianten angezeigt.

Clear Filter
Hiermit ist es mdglich, den aktuell gesetzten Filter zuriick zu setzten.

Filter Info

Hier sieht man die Kurzinfo zu dem momentan verwendeten Filter.Es wird unter anderem die Spalte auf die ein
Filter gesetzt wurde gezeigt und der Wert nach dem gesucht wird.

13



Tools

e) S a%d -

Horme Tools Wiew Help

= &
— :] =0
Options \."arian.t

Manag
Tools T

Options (Settings)
Unter Options (Settings) kénnen Sie allgemeine Einstellungen der Applikation sowie auch den Import und

Export verandern. Auch das automatische Nummerieren der Daten kénnen Sie hier Ihren Anspriichen
anpassen. Au3erdem kénnen Sie hier auch das Ausgabeformat nach lhren Wiinschen definieren.

Variant Manager

Sofern eine gliltige Lizenz vorhanden ist, kann hier der Variant Manager/ Organizer aufgerufen werden.

Mit dem BOM Extractor Variant Manager ist es dem Anwender mdglich, die Varianten in einem extra CSK
programmierten Tool zu verwalten.

Hier kdnnen Varianten neu hinzugefligt, bearbeitet und kopiert werden. Nachdem ein paar Varianten erstellt
wurden, sendet man die Varianten Information zum CADSTAR und zwar mit der vom BOM Extractor gewohnten
Bequemlichkeit (entweder die Informationen fir eine Variante oder fur alle im Tool definierten Varianten).

14



View

Wiew Help

Column  Refresh
Chooser

View ]

Column Chooser

Rufen Sie hiermit den Column Chooser auf, mit dem Sie die Auswahl der angezeigten Spalten verandern
kénnen.

Refresh

Importieren Sie Uber diesen Punkt erneut die Daten aus dem aktuellen CADSTAR-Design (auch tber F5
moglich).

15
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Help

Unter dem MenUpunkt ,Help“ sind allgemeine Informationen und das Hilfesystem vom BOM Extractor zu finden.

'O S w%a -
A Home Tools View
0 F De A w s

Contents Cnline User CSK Send Technical Remote Help About BOM-
& Index  Documentation Manual Online Feedback  Suppert -Desktop Extractor
Help P

Contents and Index

Uber diesen Meniipunkt erhalten Sie eine kleine ,Hilfe Datei“, die fast genauso aufgebaut ist, wie diese
Dokumentation. Mit dem Unterschied, dass diese kleine Hilfe Datei auch aus den BOM Extractor Fenstern
angesprungen wird. Beispiel: Sie haben ein Fenster aufgemacht und wissen nicht, was Sie mit einem
bestimmten Knopf anzufangen haben. Dann klicken Sie in diesem Fenster auf den ,Help*“ Knopf und es 6ffnet
sich diese Hilfe Datei. Zusatzlich wird die passende Seite zu dem Fenster aufgemacht.

0 - &
Ausblenden  Zunick Drucken Optionen

Inhatt | Index | Suchen

@ Overview
= ([J] CADSTAR BOM Extractor
= [[) What's New in BOM Extractor

B rtroduction|
@ Installation

@ BOM Bdractor Forms What’s New in BOM Extractor

- Schema Folder
If you want to manage multiple schema files,
set under Tools -» Settings -»= General "Sch
where the schemas are stored. This path is-

>

Online-Documentation

Hierliber haben Sie die Mdglichkeit auf weitere Dokumentationen, die online zur Verfligung stehen, zuzugreifen.

BOM Extractor User Manuel

Hiermit 6ffnen Sie genau diese Dokumentation.

CSK-Online

Hier finden Sie alles rund um die CSK Software auf der Homepage.

Send Feedback

Senden Sie uns ein Feedback beziglich Ihrer Winsche, Anfragen, Anregungen oder Beschwerden.

Technical Support

Sollten technische Probleme auftauchen, kdnnen Sie es uns Uber diesen Menupunkt mitteilen.

Remote Support

Sollten Sie gar nicht mehr weiter kommen, kénnen Sie auch unseren kostenlosen ,Remote Support® in
Anspruch nehmen. Dabei wird eine Online Sitzung von unserer Seite aus gestartet. Sie kommen Uber diesen
Menupunkt zu dieser Sitzung dazu. Dabei werden wir mit Threm Einverstandnis, Ihren Desktop sehen und ggf.
Remote darauf zugreifen, um den BOM Extractor fernzusteuern.

Dabei verwenden wir die Software ,GoToMeeting®, der Firma Citrix Systems, Inc..
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About BOM Extractor

Hier kdnnen Sie allgemeine Informationen zu der Software, dem Unternehmen und der Lizenzgiiltigkeit sehen.

CSKACAD Systeme Kluwetasch e K. CADSTAR B.O.M Exdractor 15.0
Version: 201503-17-3

Online-Documentation: CADSTAR B.O.M Extractor 15 Help

Hotline: Hotline de

Compary: CSK-LCAD Systeme Kluwetasch e K.
Country: Gemany
Zip Code: 24161
Town: Altenholz
+45-431-329170
+49-431-32917-26
Hotline: de
http://www.cskl.de

Licence expiration Date: 31.12.2015

CADSTAR BOM Edractor is a registered trademark of
CSK-ACAD Systeme Kluwetasch e K.

Software

Hier sehen Sie den aktuellen Verkaufsnamen von BOM Extractor.
Unter der Version sehen Sie die korrekte Entwicklungsversion.
Das Datum der vorliegenden Softwareversion ist wie folgt aufgebaut: Jahr — Monat — Tag — laufende Nummer.

Company
Hier sehen Sie alles rund um CSK.

Lizenz Gultigkeit
Hier sehen Sie das Ablaufdatum lhre vorhandenen Lizenz.
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VI. Options/ Settings
Hier kdnnen Sie allgemeine Parameter fur die Applikation wie auch fir den Import und Export einstellen.

General

General
] Mways Top Most

0 Hide CADSTAR
{fast Import)

[] Muto Clear

Choose your available settings

Position Setting
Start: |0 = Step:|5 =

Set Help Language

Schema Folder:
D201 5BOM_Edractor’.Schemas

Choose Schema Folder

Always Top Most

Wenn Sie diese Funktionalitat aktivieren, erscheint die Applikation immer Uber alle anderen Programme.
Gerade bei Arbeitsplatzen mit beschranktem Platz auf dem Monitor kann dies hilfreich sein, wenn der BOM
Extractor Uber CADSTAR platziert wird.

Hide CADSTAR (fast Import)

Waéhrend des Imports wird bei Aktivierung diese Funktion der CADSTAR in den ,Hidden-Modus* geschaltet.
Das bedeutet, dass CADSTAR wahrend des Importvorganges fir den Benutzer unsichtbar ist, wodurch ein
schnellerer Import der Parts moglich ist.

Auto Clear

Wenn Sie ,AutoClear” einhaken wird das Arbeitsdisplay nach dem Einladen des ,Schemas* geleert. Und erst
dann werden neue Informationen aus dem CADSTAR Design geladen.

Position Setting

Fur die automatische Durchnummerierung der Bauteile kbnnen Sie hier die Startnummer wie auch die
Schrittweite festlegen.

Schema Folder

Wenn Sie mehrere Schema Files verwalten méchten, konnen Sie hier unter ,Schema Folder” den Pfad
einstellen, wo die Schemas abgespeichert sind. Dieser Pfad wird dann auch im Schema abgespeichert.
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Menu Style
Choos=e your available settings hene
Ve e
Style Color: | Blue w
tems
i Atributes
... Variants
Menu Style

Hiermit ist es moglich, den Style des Meniis zu verandern. Zur Auswahl stehen folgende Styles:
Office 2007 / Office 2010 / Office 2013. Diese Anderung wird sofort sichtbar.

Office 2007:

EEXT=D

Home Tools View Help

Ea ;@ Variants : Variante A, 1.1 o] Mot filtered
3 o .
P o Schemas : WS_Schema_v4 Clear Mo filter column
Components  selected oSlectedltems:  28/28 Selected Variants:7 /7 filter Mo filter value
Home I5

Office 2010:

Home Tools View Help

Ea ;@ Variants: Variante A.1.1 - W( Mot filtered
‘ fems % Schemas : WS _Schema_v4 - Clear Mo filter column
Components  selected Selected ltems: 28 /28 Selected Variants 7 /7 filter Mo filter value
Home (]
Office 2013:
EEYEE
Home Tools View Help
Eé {% Variants : Variante &.1.1 -] p( Mot filtered
Exl Schemas 'WS_Schema_v4 - Mo filter column
Get Si lear
Components  selected Selected ltems: 28 /28 Selected Variants:7 /7 filter Mo filter value
Home [
Style Color

Hiermit ist es moglich die Farben des Menus einzustellen. Diese Anderung wird sofort sichtbar.
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Import-Design

Design
Al Sheets

Choose your available settings

Include Design Title

[ Load Exclusions

Exclusions...

All Sheets
Bei Aktivierung werden bei ,Get Components*® alle Sheets des geladenen Designs importiert.

Load Exclusions

Beim Importieren werden automatisch die hier eingestellten Exclusions geladen. Bauteile dessen Partnamen
bzw. Component-Bezeichnungen, sich in diesen Dateien befinden, werden automatisch vor dem Export
deselektiert.
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Import-ltems

tems
Comg

Component
[] Testpoint

Choose your available settings

(@) detailed listed

() accumulated

Package Accumulated

Component Names
[ Load Suppress

Columns Chooser Sort Order

Component
Bei Aktivierung werden die Bauteile eingeladen (Standardeinstellung: aktiv).

Testpoint
Bei Aktivierung werden Testpunkte/ Testpoints eingeladen.

Detailed listed
Bauteile werden einzeln aufgelistet (Standardeinstellung: aktiv).

Accumulated

Anstatt dass jedes Teil einzeln aufgelistet wird, kdnnen diese auch akkumuliert eingelesen werden. Es werden
dann Parts gleichen Typs in einer Zeile zusammengefasst. Wenn unterschiedliche Werte fur eine Property
existieren, dann wird ,$$$“ eingetragen.

Package Accumulated

Multigatter-Bauteile werden standardmé&Rig einzeln aufgelistet. Bei Aktivierung werden die Gatter zu einem
Bauteil zusammengefasst. Wenn unterschiedliche Werte fur eine Property existieren, dann wird ,$$3$"
eingetragen.

Suppress

In der Textbox kénnen Component Namen oder Anfangsbuchstaben von Components durch Komma getrennt
eingegeben werden. Beim Driicken auf OK werden alle Bauteile, die mit den eingetragenen Werten beginnen
deselektiert. Diese Funktionalitat kann nur ausgefiihrt werden, wenn bereits Bauteile eingeladen wurden.

Component Names
Load Suppress

C1.R1.TP.IC
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Import-Attributes

Choose your available settings Attributes
[] Part Definition Attributes

Part Definition Column Prefix
|PD_

[] Symbal / Component Definition Attributes

Symbaol # Component Definition Calumn Prefic
|sc_

[] Documentation Definition Attributes

Documentation Definition Calumn Prefic
|Doc_

Hier kdnnen Sie weitere Einstellungen tatigen, mit denen Sie zusétzliche Informationen von Bauteilen auslesen
kénnen, wie z.B. Part Definition / Symbol Definition oder Dokumentation Definition.

Wenn die jeweilige Zusatzinformation ausgewahlt wurde, ist es moglich festzulegen, wie die Attributenamen
beginnen sollen. Da es sein kann das diese Attributebezeichnungen schon existieren, sollten diese mit eigenen
Prafixen anfangen.

Standardeinstellung ist immer (PD_) fur Part Definition, (SC_) fir Symbol/Component Definition und (Doc_) fur
die Dokumantationsattribute.
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Import-Variants

Variants

All Variants
Output Non-Fitted
] implied Flag

[] General Fitted

Choose your available settings

All Variants
Bei Aktivierung werden alle Varianten des geladenen Designs ausgelesen und in den BOM Extractor importiert.

Output Non-Fitted

Es werden alle Bauteile einer Variante eingeladen inklusive der nicht bestiickten. Diese werden in der Spalte
L,Fitted” mit dem Eintrag ,NOT FITTED" bzw ,0“ vermerkt.

Implied Flag

Es werden nur Bauteile einer Variante eingeladen, die nicht bestiickt sind. Diese Funktionalitat steht nur zur
Verfligung, wenn auch ,,Output Non-Fitted“ aktiviert ist (siehe oben).

General Fitted

Bei Multigatter-Bauteilen kann es passieren, dass einzelne Gatter bestiickt und andere nicht bestiickt sind. Bei
Aktivierung werden alle Gatter auf ,NOT-FITTED" geschaltet, wenn mindestens ein Gatter nicht bestlckt ist.

23



Export—Variant

Choose your available settings Variant
Fitted Output Options

) CADSTAR (Fitted/Not-Fitted)
® MRPLINK (1/0)

WVariant Output Options
Export All Variarts

Separate Vanants Export

[ Delete Varant Name Column
[] Ignore <MD VARIANTS > Name

Fitted Output Options

Beim Exportieren kann die Eigenschaft “Fitted” ausgegeben werden, die besagt, ob ein Bauteil bestlick ist oder
nicht. Mit dieser Einstellung kdnnen Sie bestimmen, ob in der Ausgabedatei diese Eigenschaft mit den Wortern
.,FITTED/NOT-FITTED" dargestellt werden oder mit den boolschen Werten ,1/0“. Letztere Einstellung ist
meistens zur Weiterverarbeitung vorteilhaft, wenn die Daten zum Beispiel in eine Datenbank eingeladen werden
sollen (wie z.B. MRP-Link oder SAP).

Export All Variants

Hiermit werden alle Varianten exportiert unabhangig davon was im Datenfenster angezeigt wird oder wonach
gefiltert wurde.

Separate Variants Export
Hiermit wird jede Variante in einzelne CSV exportiert.

Delete Variant Name Column
Hiermit wird die Spalte ,VariantName* vor dem exportieren aus der Tabelle entfernt.

Ignore <NO VARIANTS> Name

Wenn die Option ,Export All Variants' gewahlt wurde, aber keine Varianten vorhanden sind wird eine CSV mit
dem Namen <NO VARIANTS> ausgegeben. Wenn diese Option zusatzlich dazu gewahlt wird, soll der
CADSTAR Design Name fur die CSV Datei verwendet werden und nicht <NO VARIANTS>.
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Export—Export

Choose your available settings Export
Export Files

CS5V Options
Delimiter Qualifier

: @ C5V
[ Import .
o () XML

) Comma (@ Qualfier ="

(® Semicalon () No qualifier
() Cther

File Path:
D 2015\BOM_BExtractorOutput BOM-Extractor cav

Choose File Path
Export File Options

Path : () Design Path (@) User Path
Prafix : [ Include Design Type

Name : () Design Mame (@ Varant Name () User Name

Sufic - [ Include Design Type
Owenwrite File  [_| Auto Open File

Export Files

Hier kdnnen Sie das CSV-Format (Delimiter=Trennzeichen und Qualifier=Kennzeichner) definieren, in dem die
CSV-Datei erstellt werden soll. Zudem kdnnen Sie festlegen, welches Format (CSV oder XML) das Export-File
besitzen soll, wenn Sie den BOM Extractor via Autorun vom CADSTAR direkt starten.

Export File Options
Hier kbnnen Sie den Ausgabepfad und die Bezeichnung definieren.

File Path
Hiermit stellt man einen Ausgabepfad ein.

Path

Hiermit bestimmt man den Ausgabepfad wohin die CSV geschrieben werden soll.
Zur Auswahl steht CADSTAR Design Path / User Path zu Verflgung.

Prafix
Hiermit fugt man dem Exportnamen ein Préfix hinzu.( http://de.wikipedia.org/wiki/Pr%C3%A4fix)

Name

Hiermit bestimmt man den Ausgabenamen der CSV.
Zur Auswahl steht Design Name / Variant Name / User Name.

Suffix
Hiermit figt man dem Exportnamen ein Suffix hinzu. (http://de.wikipedia.org/wiki/Suffix)

Include Design Type
Hiermit figt man dem Préfix oder Suffix den Design Typen hinzu. z.B: PCB_/ SCM_

Overwrite File
Hiermit wird fest gelegt, dass die Datei ersetzt werden soll, sollte diese schon existieren.

Auto Open File
Hiermit wird die ausgegebene Datei unverziglich gestartet/ geoffnet.
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VII.  Kontext-Menu

Alignment Data View by Column Text
Alignment Data View by Cell Text

Column Chooser

Item Properties

Find in CADSTAR

Selected 3
Rows 3
Textfilter 3
Varianten Manager »
Exclusions...

Export 3
Renumber Position

Sort By Order

Copy

Alignment Data View by Column Text
Der langste Text bestimmt die Spaltenbreite.

Alignment Data View by Cell Text
Die Textlange der Spaltentberschrift bestimmt die Spaltenbreite.

Column Chooser
Es wird ein Werkzeug zum Verwalten der Spaltenansicht gestartet.

Mit dem ,,Column Chooser“ kann die Ansicht frei konfiguriert werden. So kdnnen Sie die Spaltennamen, -anzahl
und -reihenfolge beliebig andern.

| Property )

Partname

| Property &

Partnumber

Description Partname

Partrumber Quantity

Fitted

¥

[3][¥]

Part DesignVersion

SymbolDesignVersion Value

Position VariantName
£ €

Total Columng : 33 Selected Columns :
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Item Properties

Item-Properties ﬂ

Symbol Detalls Symbol/Part Replace Mode
Name Modifier. (®) Keep Existing
Di O Replace
Postion: X [3250.0 Process
Y [40000 @ Selection

() Whole Design
Onemation: 2700 |2

[ Foed Scale {Mul:Div}:
[ Mirored
&
Varant: {no vanants defined}
Symbol Definition Details
Reference:  DIODE
Atemate:  Horizontal
Library Path
Design Version: 1
Library Version:
Part Details
Name: Ng14
Number. 101403
Description: ~ High-speed diode
Library Path
Part Pin

[] Names/Numbers
Library Version Visible

Design Version: 1

OK Cancel Attributes More Help

Hiermit rufen Sie das ,Item Property‘ Fenster auf, das alle wichtigen Informationen Uber dieses Bauteil im
CADSTAR-Design beinhaltet.

Find in CADSTAR
Es wird das gerade im BOM Extractor selektierte Bauteil im CADSTAR-Design gesucht und selektiert.

Selected
Hiermit kénnen Sie alle im BOM Extractor markierten Bauteile selektieren oder zurticksetzen.

Rows
Mit dieser Funktion haben Sie die Mdglichkeit, nicht selektierte Zeilen auszublenden und wieder einzublenden.

Textfilter
Mit dem Textfilter kbnnen Sie Ihre Sicht so weit wie mdglich eingrenzen. Ganz einfach wie in Excel.

Varianten Manager

Unter dem Menupunkt kénnen Sie lhre Varianten verwalten. Sollten Sie im Design mehrere Varianten haben,
kénnen Sie diese im BOM Extractor alle auf einmal einlesen. Und danach jede einzelne Variante exportieren.
Somit haben Sie nur einmal eigelesen und kénnen beliebig exportieren.

Exclusions

Rufen Sie hier Ihre Exclusion-Dateien auf. Bauteile dessen Partnamen bzw. Component-Bezeichnungen, sich in
diesen Dateien befinden, werden automatisch ausgehakt, sollten Sie selektiert sein.

Export

Schreiben Sie hiermit lhre selektierten Parts als CSV- oder XML-Datei raus. Weitere Einstellungen hierfur
finden Sie unter Tools>Options> Export

Renumber Position

Nummerieren Sie lhre Bauteile anhand der aktuellen Reihenfolge. Weiter Einstellungen wie Starthummer und
Schrittweite kénnen Sie unter Tools=2Options=>General vornehmen.

Sort By Order

Hiermit kdnnen Sie Ihre Spalten sortieren. Dafiir knnen Sie unter Tools2>Options2>Import=>Items erweiterte
Sortiereinstellungen vornehmen.
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VIIl.  Automatisierung

Syntax der Parameteribergabe

Ein Argumenteintrag beginnt mit einem Slash (,/“) gefolgt von dem Parameternamen. Dann kommt eine
Leerstelle (Space) als Trennzeichen, woraufhin dann der Wert des Parameters folgt. Sollen weitere Parameter
Ubergeben werden, so beginnt hiernach der nachste wieder mit einem Slash (,/“) usw. Siehe weiter unten...

Parameterbeginn = Rot
Parametername = Grin
Parameterwert =
Parameter

AutoRun

Mit Hilfe dieses Parameters ist es moglich, den BOM Extractor automatisch durchlaufen zu lassen
(Voraussetzung fiir einen automatischen Durchlauf ist die Ubergabe eines Schemas, siehe oben). Folgende
Werte kénnen Sie fir den ,AutoRun“ Parameter mit Gibergeben (Yes/No)

Beispiel: /AutoRun
Oder
Beispiel: /AutoRun

Schema

Wenn Sie ein Schema haben, tragen Sie einfach den Pfad ein, an dem das Schema sich befindet und dazu
noch den Schema-Namen.

Beispiel: /Schema E:\2015\ Bom_Extractor\Schemas\Export_All.xml

ExportPath

Es lasst sich ab sofort ein externes Ausgabeverzeichnis mit an den BOM Extractor Ubergeben.Wenn ein
externes Ausgabeverzeichnis mit Ubergeben wird, erkennt der BOM Extractor, dass dieser Pfad fir den Export
verwendet werden soll und nicht der aus dem Schema.

Info:

Der externe Pfad kann wahlweise mit und ohne Dateinamen tbergeben werden. Wenn ein Dateiname
Ubergeben werden sollte, wird dieser auch vom BOM Extractor verwendet. Wenn kein Dateiname ubergeben
werden sollte, dann schaut der BOM Extractor was in dem Schema gewahlt ist und Ubernimmt diesen Namen.

Beispiel: /ExportPath E:\2015\ Bom_Extractor\Schemas\Extern_Output\
Oder
Beispiel: /ExportPath E:\2015\ Bom_Extractor\Schemas\Extern_Output\Test.csv
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Aufruf Beispiele

Hier werden ein paar Beispiele aufgefiihrt von wo und wie der BOM Extractor gestartet werden kann.

MRP-Link

Aus dem MRP-Link kann der BOM Extractor folgendermassen gestartet werden.
Zuerst sollte der BOM Extractor als Applikation im MRP-Link eingetragen werden.
Gesteuert wird der BOM Extractor dann tber das ,Arguments’ Feld.

Hier ein Beispiel wie der Applikationsaufruf im MRP-Link aussehen sollte:

Application
Application-Reset:

-~ General Extemel Tools
- Initiglize

Choose your settings

- Forms
- Tables Tools

- CADSTAR BOM-Extractor
- Server

- Parts Stock

- Application
--ODBC

- BOM-Management
- Performance Displayed Name | BOM-Exractor

Filenams C:\Program Filss (x36NCSK - CAD Systeme Kluwsta | Erowse |
Arguments fAtoconnect Yes/Schema EN2015\Schemas \Bp

Image Name CustomerTools_32x32s % | Order Number

Small Image Name|CustomefToo|5_‘|&:‘|6,! v| Button Sizel Large v|
Toal Tip |

| Impart Applications || Export Applications |

Folgende Aufrufe kbnnen eingegeben werden.
Beispielbefehle fir die Argumentenzeile

Beispiel automatisches Durchlaufen des BOM Extractors:
/AutoRun /Schema

Beispiel automatisches Durchlaufen des BOM Extractors mit Ubergabe des externen Pfades:

/AutoRun /Schema /ExportPath

Oder

Beispiel automatisches Durchlaufen des BOM Extractors mit Ubergabe des externen Pfades + Dateinamen:
/AutoRun Yes/Schema E:\2015\Schemas\Export_All.xml/ExportPath D:\2015\Extern_Output\Test.csv

Beispiel kein automatisches Durchlaufen des BOM Extractors aber daftir mit Laden des Schemas:
/AutoRun No/Schema
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CADSTAR

Unter CADSTAR Tools - Options ist es unter dem Reiter ,Tools* moglich, externe Programme in CADSTAR
einzubinden. Zudem kdénnen Uber ,Arguments“ Parameter zum Starten der Programme Ubergeben werden. Der
BOM Extractor unterstitzt diese Funktionalitéat mit den im folgenden Beispiel erlauterten Befehlen.

Der BOM Extractor muss im CADSTAR genauso eingetragen werden wie auch im MRP-Link unter
Tools>Options>Application dann kdnnen auch die Befehle wie im MRP-Link Beispiel verwendet werden,
wenn der BOM Extractor einen eigenen Lizenzcode besitzt und im Singlemode gestartet werden kann.

Beispielbefehle fiir die Argumentenzeile

Beispiel automatisches Durchlaufen des BOM Extractors:
/AutoRun /Schema

Beispiel automatisches Durchlaufen des BOMExtractors mit Ubergabe des externen Pfades:

/AutoRun /Schema /ExportPath

Oder

Beispiel automatisches Durchlaufen des BOM Extractors mit Ubergabe des externen Pfades + Dateinamen:
/AutoRun Yes/Schema E:\2015\Schemas\Export_All.xml/ExportPath D:\2015\Extern_Output\Test.csv

Beispiel kein automatisches Durchlaufen des BOM Extractors aber dafiir mit Laden des Schemas:
/AutoRun No/Schema

So sieht der direkte BOM Extractor Aufruf im CADSTAR aus:

System | File Locations | Library Paths | Interaction | Display | Constraints | Cross Probing | Feports | Tools | Macros | D51

Tools on Menu
Add...
B0k -E wtractor

Delete

Menu MName BOM-Eutractar

Eilename C:Program Fj - CAD Systeme Kluwetaschh\CaDs | |
Arguments stutoRun Yes/Schema E:5201545 chemasz E xport_All.xml/E =p

Initial Directom

Cancel

CADSTAR Arguments unterstitzt ca. 250 Zeichen, alles was mehr Zeichen hat wird abgeschnitten. Sollte man
das Problem haben, dass die Pfade zulang sind, ist es mdglich entweder den BOM Extractor ber den MRP-
Link zu starten (denn da hat man keine Begrenzung bei der Eingabe des Arguments, Vorraussetzung hierfir ist
allerdings eine BOM-Extractor Lizenz im MRP-Link) oder man erzeugt eine Batchdatei mit den nétigen Aufrufen
und startet aus dem CADSTAR die Batchdatei. Sowohl mit dem MRP-Link als auch mit einer Batchdatei kann
man somit die 250 Zeichen Grenze umgehen.

Beispiele fiir das Starten des BOM Extractors tiber den MRP-Link oder Uber eine Batchdatei sehen Sie weiter
unten.
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Wenn der BOM Extractor uber den MRP-Link gestartet und somit auch die Lizenz dartiber bezogen werden soll
dann sollen/ kdénnen folgende Beispielbefehle eingegeben werden.

Info:

Die jetzt in den eckigen Klammern ibergebenen Parameter werden zuerst im MRP-Link aufbereitet und dann
an den BOM Extractor so weitergegeben, wie der es interpretieren kann. Diese Ubergabeparameter miissen
anders uibergeben werden, damit der MRP-Link interpretieren kann, dass es Ubergabeparameter fiir den BOM
Extractor sind und nicht fur MRP-Link. Deswegen missen alle Paramter die an BOM Extractor iber den MRP-
Link Gbergeben werden sollen in eckigen Klammern eingeschlossen sein. Aulerdem wird der Paramter
innerhalb der eckigen Klammern mit einem Ausrufezeichen ,!“ eingeleitet und nicht wie sonst mit einem Slash
Wl

Beispielbefehle fir die CADSTAR Argumentenzeile

Beispiel automatisches Starten und Durchlaufen des BOM Extractors iber den MRP-Link:

/Autoconnect /Application

Info:

Diese ,Application® die hier aufgefiihrt wird, muss auch so im ,MRP-Link/Application® eingetragen sein.
AuBerdem werden die Einstellungen Gbernommen die im MRP-Link tber die Argumentenzeile im Rahmen
eines Schemas mit Ubergeben werden.

Beispiel automatisches Durchlaufen des BOM Extractors mit Ubergabe der externen Einstellungen:
/Autoconnect /Application [! ]

Beispiel automatisches Durchlaufen des BOM Extractors mit Ubergabe des externen Exportpfades:
/Autoconnect /Application [! IExportPath

]
Oder
Beispiel automatisches Durchlaufen des BOM Extractors mit Ubergabe des externen Exportpfades &
Dateinamen:
/Autoconnect Yes/ Application BOM-Extractor[!Schema E:\2015\Schemas\Export_All.xml/ExportPath
D:\2015\Extern_Output\Test.csv]

So sieht der BOM Extractor Aufruf Gber den MRP-Link im CADSTAR aus:

System | File Locations | Library Paths | Interaction | Display | Constraints | Cross Probing | Feports | Tools | Macios | D51

Tools on Menu

B0k -E rtractor

Menu Mame BOM-Extractar
Filename C:4Program Files [=26]4C5E - CAD Spsteme KluwetaschiyWAP-L
Arqurients fautoconnect yestdpplication BOM-Extractar|SCHEMA D420

Initial Directomn

Cancel
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Batchdateien

In den Batchdateien kdnnen alle Beispielbefehle wie im MRP-Link oder CADSTAR beschrieben verwendet
werden. Man muss nur eine Datei mit der Endung .bat erstellen und diese dann mit dem Texteditor bearbeiten.
In die Batchdatei kommt dann der Pfad des Programms das gestartet werden soll rein und einer der
beschriebenen Befehle.

Beispiel automatisches Durchlaufen des BOM Extractors mit Ubergabe der externen Einstellungen und des
externen Exportpfades:

Dater Bearbeiten Format  Ansicht 2

"C:\Program Files (x86)\CSK - CAD Systeme Kluwetasch\CADSTAR BOM-Extractor 15.8\Programs\BOM_Extractor.exe"

fAutorun yes/Schema E:\2015\Schemas\Export_All.xml/ExportPath D:\2@15\Extern_Output\Test.csv

<

Beispiel automatisches Starten und Durchlaufen des BOM Extractors tGiber den MRP-Link ohne Parameter:

Datei Bearbeiten Format Ansicht 7
"C:\Program Files (x86)\CSK - CAD Systeme Kluwetasch\MRP-Link 15.@\Programs\MRPLink.exe" /autoconnect yes/Application BOM

Beispiel automatisches Starten und durchlaufen des BOM Extractors tiber den MRP-Link mit Parametern:

Datei Bearbeiten Format Ansicht 7
"C:\Program Files (xB6)\CSK - CAD Systeme Kluwetasch\MRP-Link 15.@\Programs\MRPLink.exe"

fautoconnect yes
/Application BOM[!SCHEMA D:\2815\BOM_Extractor\Schemas\WS_Schema_v5.xml!EXPORTPATH D:\2815\BOM_Extractor\Extern_Output\]

J/Function ExitMRPLink

<

Wichtig: Aus Platzgriinden fur die Bilder, wurden die Aufrufe in der Batchdatei untereinander geschrieben.
Es muss alles in einer Zeile geschrieben werden wie im Beispiel 2 gezeigt,
sonst wird die Batchdatei nicht ausgefihrt.
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BOM Extractor ist erstellt von:

) ¢

CSK - CAD Systeme Kluwetasch e.K.

Struckbrook 49

24161 Altenholz
Deutschland

Tel. +49-431-329170
Fax +49-431-3291726

Web http://www.cskl.de
E-Mail: Kluwetasch@cskl.de
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